
日本 Apache Camel ユーザ会

「Apache Camel」

適用事例紹介 ＆ 超入門

日本 Apache Camel ユーザ会

古関 伸行

2012年 12月 8日 （土）



2

日本 Apache Camel ユーザ会

発表者

� 古関 伸行（こせき のぶゆき）

� やっていること

� 以前：

EAI/BPM製品の展開、導入支援

SOA関連情報の展開

� 最近：

Camelを使って既存商用EAI製品案件勢力図をぬりかえ

るべく活動中

（といいつつ、私も Camel 初心者です！！）
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発表内容

この発表では、

� Apache Camelはどういったものか？

� Apache Camelをどのように使うか？

について説明します。
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Apache Camelとは？

Camelを一言でいえば、

� 多数のコンポーネントが使える

�ルーティングエンジン

です。

…って、意味分かります？
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Apache Camelとは？

つまり…

別々のシステム同士や、

異なるアプリ同士をつなげて、

データのやり取りを簡単に実現したい

そんなときに役に立つ（かもしれない)ツールです。
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Apache Camelとは？

～背景～

� Apache Software Foundationのプロダクトの一つ

� 2007年にリリース（ActiveMQのサブプロジェクト）

� ２００９年にトッププロジェクトになる

� 数ヶ月毎にバージョンアップ
→結構活発に活動
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Apache Camelとは？
～何ができるか？ その１～

� 例えば、手作業を効率化

担当者

社内サーバ 外部の会社 社内サーバ 外部の会社

Camel導入前 Camel導入後

CamelCamelCamelCamel

・担当者が手作業で実施 ・Camelが自動で実施

手作業で
再投入

Camelで
自動流通
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Apache Camelとは？
～何ができるか？ その２～

� 例えば、スパゲティな連携を簡素化

新規サーバ

・メンテナンスが煩雑
・各システムが接続先を意識

新規サーバ

CamelCamelCamelCamel

・メンテナンスはCamelに集約
・Camelが接続先を振り分ける

JDBC

FTP

JMS

SOAP
SOAP

SOAP

JDBC

FTP

SOAP

多数の接続
先を意識

接続先は
ひとつ
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Apache Camelとは？
～何ができるか？ その３～

� 例えばCamelの部品を利用したら…

CamelCamelCamelCamel一定間隔/決まった日時に
特定の処理を実行

ラウンドロビンでの
負荷分散

CamelCamelCamelCamel

流通データ量の制御
CamelCamelCamelCamel

シェルコマンド実行

サーバA

サーバB

・NW帯域制限

・マシンリソース制限
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機能追加

Apache Camelとは？
～何ができるか？ その４～

� Camelと他の機能を組み合わせると…

CamelCamelCamelCamelCamelCamelCamelCamel

◆ Camelをベースに機能拡張

ESBとか

CamelCamelCamelCamelCamelCamelCamelCamel

◆ Camelと別機能の組合せ

BPM＋ EAI/BPM

CamelCamelCamelCamelCamelCamelCamelCamel Rule＋ CEPもどき

*ESB ： Enterprise Service Bus
*EAI/BPM ： Enterprise Application Integration / Business Process Management
*CEP ： Complex Event Processing

*ESB ： Enterprise Service Bus
*EAI/BPM ： Enterprise Application Integration / Business Process Management
*CEP ： Complex Event Processing

と
っ
て
も
高
価
な
商
用
製
品
と

同
じ
よ
う
な
こ
と
を
、

安
価
に
実
現
で
き
る
可
能
性
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Apache Camelとは？

～まとめてみる～

� ルーティングエンジン

� データを右から左にルーティングさせるエンジン

� プロトコルやデータフォーマットの変更も可能

CamelCamelCamelCamel

SOAP JDBC

� コンポーネント（部品)

� 色んなプロトコルと連携する部品

� データ変換用の部品

� 使い道の不明な部品、等々
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� Apache Camelとは？

� Apache Camelの適用事例紹介

� Camel概要

� Camelの使い方

� さらに深くCamelを知る

� Camelコードサンプル
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Apache Camelの適用事例紹介

前にも書きましたが…

CamelCamelCamelCamelCamelCamelCamelCamel

◆ Camelと別機能の組合せ

BPM＋ EAI/BPM

CamelCamelCamelCamelCamelCamelCamelCamel Rule＋ CEPもどき

この2つの事例について紹介します
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Apache Camelの適用事例紹介
～ その① ～

既にそこそこの規模のシステムで稼動中
� 案件概要

� システム概要
オーダの開通設定、開通試験の指示、試験結果情
報の更新等を行うシステム

� システムカバー範囲
東日本全域

� 商用EAI/BPMで稼働しているシステムの更改
・EAI機能はApache Camelで、
・BPM機能はｊBoss ｊBPMでリプレース
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Apache Camelの適用事例紹介
～ その① ～

� 特色
Apache Camelで複数システム同士を連携

・ SOAPで連携

・ JDBCで連携(Ｏｒａｃｌｅ接続)

・ JMS（Oracle Advanced Queue）でｊBPMと連携

� Apache Camelを導入しての感想
・ 商用EAI製品と遜色ない生産性、品質
（バグが少なすぎる！！ と、強化試験を実施）
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Apache Camelの適用事例紹介
～ その① ～

� ハードウェア構成（一部抜粋）

� ＡＰサーバと同居して、同一ＶＭ上で動作

【EAI/BPM/APサーバ構成】
CPU：Intel Xeon 2.13GHz ４コア
メモリ：４８G

Webサーバ
EAI/BPM/
APサーバ DBサーバ

他システムや
サブシステム群
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Apache Camelの適用事例紹介
～ その① ～

� ソフトウェアスタック（EAI/BPM/APサーバ）
� 外部システムおよび内部サブシステム接続にCamelを利用

� 商用BPM製品のOSSリプレース（jBPMへの置換）も実施

CamelCamelCamelCamel用用用用アプリアプリアプリアプリ
（Ｗｅｂ（Ｗｅｂ（Ｗｅｂ（Ｗｅｂアプリケーションアプリケーションアプリケーションアプリケーション））））

ＪＲＥＪＲＥＪＲＥＪＲＥ６６６６

ＪＢｏｓｓＪＢｏｓｓＪＢｏｓｓＪＢｏｓｓインスタンスインスタンスインスタンスインスタンス

ＥＡＩＥＡＩＥＡＩＥＡＩライブラリライブラリライブラリライブラリ群群群群 ＢＰＭＢＰＭＢＰＭＢＰＭライブラリライブラリライブラリライブラリ群群群群

ＢＰＭＢＰＭＢＰＭＢＰＭモデルモデルモデルモデル
（（（（定義定義定義定義・・・・実行実行実行実行クラスクラスクラスクラス））））

ＪＢＰＭＪＢＰＭＪＢＰＭＪＢＰＭＣａｍｅｌ／ＳｐｒｉｎｇＣａｍｅｌ／ＳｐｒｉｎｇＣａｍｅｌ／ＳｐｒｉｎｇＣａｍｅｌ／Ｓｐｒｉｎｇ
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Apache Camelの適用事例紹介
～ その② ～

� CamelとｊBoss Rulesを組合せ、CEPとして
利用。大量メッセージの検証。
※CEPとは？

大量・多種のデータを高速で分析するもの、らしい

DBサーバ
Apache Camel/ 
jBoss Rules/ 
Tomcat

クライアント
(大量メッセージ)
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Apache Camelの適用事例紹介
～ その② ～

� Ruleで大量メッセージのフィルタリング

� CamelのAggregatorでメッセージ集約
→同類のメッセージ一つにまとめる

【【【【RuleRuleRuleRule】】】】
条件条件条件条件にににに合致合致合致合致しないしないしないしない
データデータデータデータははははゴミゴミゴミゴミ箱行箱行箱行箱行きききき

×

【【【【AggregatorAggregatorAggregatorAggregator】】】】
同同同同じじじじタイプタイプタイプタイプのののの

データデータデータデータをまとめるをまとめるをまとめるをまとめる

DBに書
込み
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Apache Camelの適用事例紹介
～ その② ～

検証してみて

� CamelのAggregator部品

� 色々な条件でデータの集約が可能
→時間単位、件数単位、データの中身から、等々
→コードを書いて実現するとなると、結構大変かも

� ｊBoss Rules

� Rule用の部品がCamelにはない！
→自作するノウハウが必要
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� Apache Camelとは？

� Apache Camelの適用事例紹介

� Camel概要

� Camelの使い方

� さらに深くCamelを知る

� Camelコードサンプル



24

日本 Apache Camel ユーザ会

Camel概要
～特徴～

� Enterprise Integration Pattern (EIP)

� 優れた拡張性

� 多数のコンポーネント
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Camel概要
～Enterprise Integration Pattern (EIP)～

メッセージルーティングメッセージルーティングメッセージルーティングメッセージルーティング
メッセージメッセージメッセージメッセージ

メッセージメッセージメッセージメッセージ変換変換変換変換 分割分割分割分割

エンタープライズ統合
のノウハウ

汎用的な
パターン

メッセージチャネルメッセージチャネルメッセージチャネルメッセージチャネル

必要な機能を定義 利用時の留意点を定義

⇒⇒CamelCamelははEIPEIPのパターンを参考に機能実現のパターンを参考に機能実現

汎用的な設計パターンをGoFデザインパターンとして定義したように、
エンタープライズ統合のパターンを定義
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コ
ア
機
能

Camel概要
～優れた拡張性 １/２～

� 必要なコンポーネントのみ利用可能
� 不要なコンポーネントは使わなくてよい

� ない場合は自分で作成可能

Apache
CXF SOAP

Jetty

Apache
ActiveMQ

HTTP

ＪＭＳ

CamelCamelCamelCamelがががが提供提供提供提供 他他他他OSSOSSOSSOSS
をををを利用利用利用利用

File
ファイル

コンポーネント

判例

：コンポーネント

：OSS/ライブラリ

Webサービ
ス用Lib

HTTP用
Lib

JMS用
Lib

自作
Lib OSS Lib

個別
プロトコル



27

日本 Apache Camel ユーザ会

Camel概要
～優れた拡張性 ２/２ ～

� 単純なプロトコルスタック

� Camel本体は他ライブラリの依存度が低い

� 他システムへの組込み/組合せが容易

http://servicemix.apache.org/architecture.htmlより引用

オープンソースESBの
ServiceMixの場合

Camelと他OSSを
組み合わせて実現
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Camel概要
～多数のコンポーネント １/２～

� １００以上のコンポーネント

AHC

AMQP

APNS

Atom

AWS-SNS

AWS-SQS

AWS-S3

Bean

Bean Validation

Browse
Cache

Cometd

Context

CXF

CXF Bean

CXF RS

DataSet

Direct

DNS

EJB

EventAdmin Exec

File

Flatpack

FreeMarker

FTP

Hazelcast
HDFS

HL7

HTTP

HTTP4

iBATIS
IMap

IRC

JBI

JCR

JMS

JMX

JPA

JT/400

Kestrel

LDAP

Log

Lucene

Mail

MINA

Mock
MyBatis

Netty

POP

Quartz

RMI

RSS

Sip

SFTP

SERVLET

SMPP

SMTP

SNMP

SpringIntegration

SQL

Stream

StringTemplate
TCP

Test
Timer

XQuery

連携用のコンポーネント 役立ちそうなコンポーネント EIPのコンポーネント

Event
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Camel概要
～多数のコンポーネント ２/２～

� AWS,GAE等、注目のクラウド環境にも対応

Apache CamelApache CamelApache CamelApache Camel

S3
SNS SQS

OAuth
Mail Service

Amazon
Web
Service

Google
App
Engine

Task Queuing Service URL Fetch Service

コア機能
HTTP用

Lib

AWS用
Lib

Apache CamelApache CamelApache CamelApache Camel

コア機能
HTTP用

Lib

GAE用
Lib

HTTP用
Lib
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� Apache Camelとは？

� Apache Camelの適用事例紹介

� Camel概要

� Camelの使い方

� さらに深くCamelを知る

� Camelコードサンプル
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Camelの使い方

例えばこんなことしたい場合…

File有無
チェック

メッセージの
内容チェック

データを分割 DBに
インサート

FTPでデータ送信 DBに書込み

APサーバ上にサーブレットを作ったり、シェルを組み合わせたり、
.NETやRuby等の各種言語を使ったりして実現
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Camelの使い方

Camelの場合だと…

File有無
チェック

データの
チェック

データの分割 DBに
インサート

from(from(from(from(““““FileFileFileFile有無有無有無有無チェックチェックチェックチェック””””))))
.to(.to(.to(.to(““““データデータデータデータののののチェックチェックチェックチェック””””))))
.to(.to(.to(.to(““““データデータデータデータのののの分割分割分割分割””””))))
....to(to(to(to(““““DBDBDBDBににににインサートインサートインサートインサート””””););););

こんな風に書いて実現できます
※あくまでも雰囲気です、雰囲気。



33

日本 Apache Camel ユーザ会

Camelの使い方

XMLを使って書くこともできます。

from(from(from(from(““““FileFileFileFile有無有無有無有無チェックチェックチェックチェック””””))))
.to(.to(.to(.to(““““データデータデータデータののののチェックチェックチェックチェック””””))))
.to(.to(.to(.to(““““データデータデータデータのののの分割分割分割分割””””))))
....to(to(to(to(““““DBDBDBDBににににインサートインサートインサートインサート””””););););

<route>
<from uri=“FileFileFileFile有無有無有無有無チェックチェックチェックチェック” />

<to uri=“データデータデータデータののののチェックチェックチェックチェック” />
<to uri=“データデータデータデータのののの分割分割分割分割” />
<to uri=“DBDBDBDBににににインサートインサートインサートインサート” />

</route>

同じ処理
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Camelの使い方

� 実行時、Camelは記述されたルートに従って
メッセージをルーティングします。

File有無
チェック

データの
チェック

データの分割 DBに
インサート

中には取得したファイルの中身は勿論、ファイル
名やタイムスタンプ、取得元ディレクトリ等の情
報が詰まっている

メッセージ
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Camelの使い方
～ルーティング～

� DSLでルーティングを定義

� DSL：Domain Specific Language
Camel固有のルーティング記述用の言語

� 複数のDSLでルーティング定義が可能

� Java DSL （実際はfromやtoのメソッド）

� Spring DSL （実際はfromやtoのタグ）

� Scala DSL （勉強してないのでわかりません）
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Camelの使い方
～ルーティング～

� 処理のルートを記述するとCamelが解釈
→ルーティングエンジン
� 基本はfromで始めてtoを続けて書く

� Camelが解釈して順番に処理をする

� from,to以外にも色々記述できます
� 一直線でなく分岐させることも可能

� choiceやwhen,otherwiseの利用

分岐条件

Xの処理

Yの処理

条件X

条件Y
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Camelの使い方

ところで、何故下記のように分けているのか？

File有無
チェック

データの
チェック

データの分割 DBに
インサート

こんな分け方は駄目なの？

File有無チェック
データのチェック
データの分割

DBに
インサート

from(from(from(from(““““FileFileFileFile有無有無有無有無チェックチェックチェックチェック ￥￥￥￥
データデータデータデータののののチェックチェックチェックチェック ￥￥￥￥
データデータデータデータのののの分割分割分割分割””””))))

....to(to(to(to(““““DBDBDBDBににににインサートインサートインサートインサート””””););););

“to”の数を少なくできる？
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Camelの使い方

Camelで提供しているコンポーネントのサイズ

File有無
チェック

データの
チェック

データの分割 DBに
インサート

Fileコンポーネント

Java記述コンポーネント
（Javaで作り込む)

分割コンポーネント

MyBatisコンポーネント
SQLコンポーネント
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Camelの使い方
～コンポーネント～

� コンポーネントはURIで指定

例えば、
/tmp/abcフォルダを5秒間隔でポーリングする場合、
Fileコンポーネントを利用。スキーマ名は”file”なので、

file:/tmp/abc?delay=5000 と書ける

例えば、
/tmp/abcフォルダを5秒間隔でポーリングする場合、
Fileコンポーネントを利用。スキーマ名は”file”なので、

file:/tmp/abc?delay=5000 と書ける

スキーマ名：必須項目[？オプション]

コンポーネント
を識別するユ
ニークな名前

URIの必須情報 ・URIのオプション情報(複数記述可能)
・複数記述する場合は‘＆’でつなげる

<URIの基本>
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Camelの使い方
～コンポーネント～

� 各種プロトコルに対応したコンポーネントを用意

� 書式はすべて「スキーマ名：必須項目？オプション」

FileFile

CXF、CXFRS、RestletWebサービス関連

Google連携

Amazon連携

JMS、メッセージング関連

HTTP関連

DBアクセス

FTP関連

プロトコル

GAuth、GHｔｔｐ、GLogin、GMail

AWS-S3、AWS-DDB、AWS-SES

JMS、SJMS、MQTT

Jetty、HTTP、HTTP4

JDBC、SQL、iBatis、MyBatis

FTP、SFTP、FTPS

利用できるコンポーネント

他、多数。詳細は以下を参照。
http://camel.apache.org/components.html
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Camelの使い方
～コンポーネント～

� オプション指定で更に便利に！

file:/tmp/abc?delay=5000&move=.donefile:/tmp/abc?delay=5000&move=.done

file:/tmp/abc?delay=5000&recursive=truefile:/tmp/abc?delay=5000&recursive=true

処理後、.doneディレクトリ
にファイルを移動したい

フォルダを再帰的に
ポーリングしたい

file:/tmp/abc?delay=5000

file:/tmp/abc?delay=5000&move=.done&recursive=truefile:/tmp/abc?delay=5000&move=.done&recursive=true

どっちもやりたい
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Camelの使い方
～ルーティング例～

� コンポーネント記述の書き方の一例

File有無
チェック

データの
チェック

データの
分割

DBに
インサート

from(“file:/a/b?delay=5000” )
.to(“bean:dataCheck” )
.to(“log:com.mycompany.order?level=DEBUG” )

.split( body().tokenize(“¥n” )

.to( “mybatis:insertData?statementType=insert” );

from,to意外にも目的に応じて様々な記述が可能

ログ
出力

基本は
つなげていく！
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� Apache Camelとは？

� Apache Camelの適用事例紹介

� Camel概要

� Camelの使い方

� さらに深くCamelを知る

� Camelコードサンプル
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さらに深くCamelを知る
～内部で流通するメッセージ形式～

� メッセージの話をする前に、少しだけ一般論

厳密厳密厳密厳密にににに型型型型をををを定義定義定義定義 利用者利用者利用者利用者がががが型型型型のののの内容内容内容内容をををを意識意識意識意識

入力
処理

処理X
出力
処理

入力
処理

処理X
出力
処理

XXXX YYYY

のののの型型型型のみのみのみのみ
流通流通流通流通をををを許容許容許容許容

のののの型型型型のみのみのみのみ
流通流通流通流通をををを許容許容許容許容

のののの中中中中にににに何何何何がどのようにがどのようにがどのようにがどのように入入入入っっっっ
ているかているかているかているか、、、、ユーザユーザユーザユーザがががが意識意識意識意識

・・・・ユーザユーザユーザユーザははははデータデータデータデータへのへのへのへのアクセスアクセスアクセスアクセスがががが容易容易容易容易
・・・・全全全全てのてのてのての型定義型定義型定義型定義をををを設計時設計時設計時設計時にににに実施実施実施実施

・・・・設計時設計時設計時設計時にににに型定義型定義型定義型定義がががが不要不要不要不要
・・・・データデータデータデータへのへのへのへのアクセスアクセスアクセスアクセスをををを各処理各処理各処理各処理でででで実施実施実施実施

CamelCamelCamelCamelはこのはこのはこのはこの方法方法方法方法
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さらに深くCamelを知る
～メッセージ形式～

� メッセージは“Header”と“Body”からなる

メッセージ

Header

Body

データ以外の情報を格納

流通データを格納

メッセージの構成

※：メッセージの包む箱としてExchangeがあるけど、今回は省略。
※：またExchange内に2つのメッセージがある(InMessage、OutMessage)
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さらに深くCamelを知る
～メッセージ形式 Header～

� データ以外の情報がHeader部に詰まっている

�例えば、ファイル名やディレクトリ名を格納
�「キー＝値」の形式で格納
�プロトコル毎に格納されるキーが異なる
�ユーザが自由に追加/変更可能

メッセージ

Header

Body

[CamelFilePath=C:¥work¥abc¥File.txt]
[CamelFileLength=320]
[CamelFileLastModified=yyyy/mm/dd]
…

[Content-Type=text/xml;charset=UTF-8]
[operationNameSpace=http://ws.test.co.jp/]
[operationName=helloEcho]
…

ファイル受信時のヘッダ情報の例 Webサービス受信時のヘッダ情報の例
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さらに深くCamelを知る
～メッセージ形式 Body～

� Body部には流通データが詰まっている

�流通するデータを格納
�データ形式はプロトコルで異なる

メッセージ

Header

Body

◆クラス名は
org.apache.camel.component.file.GenericFile
◆処理対象のファイル情報を格納

◆クラス名は
org.apache.cxf.message.MessageContentsList
◆受信データのリスト、引数のデータが順番に格納

ファイル受信時のBody部 Webサービス受信時のBody部
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さらに深くCamelを知る
～データ変換～

� 自動でBody部の型変換をするTypeConverter

ファイル
入力処理

処理X

メッセージ

Body部を
byte[]で出力

Body部は
Stringで処理したい

変換可能な型をCamelが選択

Object->Byte

Map->Set

byte[]->String

byte[]->Document

File->InputStream

File->String

型変換のルールが
TypeConverterに登録
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さらに深くCamelを知る
～データ変換～

� 容易にBody部のデータ取得が可能

publicpublicpublicpublic classclassclassclass Process implementsimplementsimplementsimplements Processor {

publicpublicpublicpublic voidvoidvoidvoid process(Exchange exchange) throwsthrowsthrowsthrows Exception {

//Stringで欲しい場合

String data = exchange.getIn().getBodygetBodygetBodygetBody((((String.classString.classString.classString.class););););

//InputStreamで欲しい場合
InputStream is = exchange.getIn(). getBodygetBodygetBodygetBody((((InputStreamInputStreamInputStreamInputStream.class.class.class.class););););

//Documentで欲しい場合
Document doc = exchange.getIn(). getBodygetBodygetBodygetBody((((Document.classDocument.classDocument.classDocument.class););););

publicpublicpublicpublic classclassclassclass Process implementsimplementsimplementsimplements Processor {

publicpublicpublicpublic voidvoidvoidvoid process(Exchange exchange) throwsthrowsthrowsthrows Exception {

//Stringで欲しい場合

String data = exchange.getIn().getBodygetBodygetBodygetBody((((String.classString.classString.classString.class););););

//InputStreamで欲しい場合
InputStream is = exchange.getIn(). getBodygetBodygetBodygetBody((((InputStreamInputStreamInputStreamInputStream.class.class.class.class););););

//Documentで欲しい場合
Document doc = exchange.getIn(). getBodygetBodygetBodygetBody((((Document.classDocument.classDocument.classDocument.class););););

BodyBodyBodyBody部部部部ををををXXXXXXXXXXXXのののの型型型型でくれでくれでくれでくれ！！！！

とととと利用者利用者利用者利用者がががが宣言宣言宣言宣言するだけするだけするだけするだけ

「処理X」はいろんな型でデータが取得できる
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� Apache Camelとは？

� Apache Camelの適用事例紹介

� Camel概要

� Camelの使い方

� さらに深くCamelを知る

� Camelコードサンプル



51

日本 Apache Camel ユーザ会

Camelコードサンプル
～実際にやってみる～

� 例えば…
ファイルをコピーする処理を考えてみる

フォルダフォルダフォルダフォルダからからからから
ファイルファイルファイルファイルをををを
取得取得取得取得するするするする

フォルダフォルダフォルダフォルダにににに
ファイルファイルファイルファイルをををを
出力出力出力出力するするするする

ファイルコピー処理ファイルコピー処理
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Camelコードサンプル
～Javaで書いてみる～

� Javaでも簡単に記述可能
publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {
File inboxDirectory = newnewnewnew File("data/inbox");
File outboxDirectory = newnewnewnew File("data/outbox");
outboxDirectory.mkdir();
File[] files = inboxDirectory.listFiles();
forforforfor (File source : files) {
File dest = newnewnewnew File(outboxDirectory.getPath() + File.separator + source.getName());
copyFile(source, dest);

}
}

privateprivateprivateprivate staticstaticstaticstatic voidvoidvoidvoid copyFile(File source, File dest) throwsthrowsthrowsthrows IOException {
～ファイルのコピー処理をする～

}

publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {
File inboxDirectory = newnewnewnew File("data/inbox");
File outboxDirectory = newnewnewnew File("data/outbox");
outboxDirectory.mkdir();
File[] files = inboxDirectory.listFiles();
forforforfor (File source : files) {
File dest = newnewnewnew File(outboxDirectory.getPath() + File.separator + source.getName());
copyFile(source, dest);

}
}

privateprivateprivateprivate staticstaticstaticstatic voidvoidvoidvoid copyFile(File source, File dest) throwsthrowsthrowsthrows IOException {
～ファイルのコピー処理をする～

}
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Camelコードサンプル
～Camelでやってみる～

� Camelの場合（Java DSL)
publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {

//1：最初にCamelContextを作成する
CamelContext context = newnewnewnew DefaultCamelContext();
RouteBuilder routeBuilder = newnewnewnew FileToFileRoute();
context.addRoutes(routeBuilder);

//2:作成したCamelContextを開始し、10秒後に終了する
context.start();
Thread.sleep(10000);
context.stop();

}

publicpublicpublicpublic staticstaticstaticstatic voidvoidvoidvoid main(String args[]) throwsthrowsthrowsthrows Exception {

//1：最初にCamelContextを作成する
CamelContext context = newnewnewnew DefaultCamelContext();
RouteBuilder routeBuilder = newnewnewnew FileToFileRoute();
context.addRoutes(routeBuilder);

//2:作成したCamelContextを開始し、10秒後に終了する
context.start();
Thread.sleep(10000);
context.stop();

}

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override
publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {
from("file:data/inbox?noop=true")

.to("file:data/outbox");
}

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override
publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {
from("file:data/inbox?noop=true")

.to("file:data/outbox");
}
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Camelコードサンプル
～要件の考慮～

� ところが、普通はもっと要件が複雑…
例えば、

� 1分毎にファイルがあるかチェックすること

� 出力ファイル名には日付を付与すること

� .docの付いた拡張子は無視すること

� 同一のファイル名がある場合は無視すること

� サブフォルダも検索すること

� コピーでなく移動に変更。バックアップも取って！

� etc,…
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Camelコードサンプル
～追加要件への対応～

� Camelの場合、オプション追加で対応可能

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override

publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {

from(“file:data/inbox? delay=60000 & exclude=*.doc$ & move=.done &

noop=false & idempotent=true & recursive=true")

.to("file:data/outbox? fileName=${date:now:yyyy-MM-dd}_${file:name}");

}

publicpublicpublicpublic classclassclassclass FileToFileRoute extendsextendsextendsextends RouteBuilder {

@Override

publicpublicpublicpublic voidvoidvoidvoid configure() throwsthrowsthrowsthrows Exception {

from(“file:data/inbox? delay=60000 & exclude=*.doc$ & move=.done &

noop=false & idempotent=true & recursive=true")

.to("file:data/outbox? fileName=${date:now:yyyy-MM-dd}_${file:name}");

}

1分毎にファイルがあるかチェック

出力ファイル名には日付を付与

.docの付いた拡張子は無視

同一のファイル名がある場合は無視

サブフォルダも検索

コピーから移動に変更

.doneフォルダにバックアップ



56

日本 Apache Camel ユーザ会

さいごに（その①）
～様々な立場におけるApache Camel～

�インテグレータ View

� 安価なシステム提案
→ イニシャルコストなし

→ ランニングコストはメンテナンスに必要な稼働を請求！？

� 国内でApache Camel先駆者となれる
→ 国内での利用ユーザはほんの僅か、

使い倒して競合他社との差別化！？

� 容易な開発体制の確立
→ 専門技術者を集める必要なし、Java技術者にて開発可能
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さいごに（その①）
～様々な立場におけるApache Camel～

�エンドユーザ View

� 安価なシステム構築
→ イニシャルコストなし

→ 必要なのはメンテナンス費用（≒保守費）

→ ポジティブに考えるといつでも捨てれる！？

→ OSSの積極的な利用によるコストダウン体制をアピール
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さいごに（その②）
～ユーザ会を立ち上げました～

� 皆さんにCamelを知って欲しい！

� 日本Apache Camelユーザ会

【お勉強系サイト】

http://sourceforge.jp/projects/cameluserjp/

【キャラ系サイト】

https://sites.google.com/site/jaacug/

� 主な活動内容
� Camelのドキュメント翻訳

� Camelのサンプル実装

等をやりたいと思っています。
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ご静聴
ありがとうございました


